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ASCENDER - NYR Payroll Process Quick
Checklist

This checklist provides a quick at-a-glance view of the steps listed in the complete ASCENDER -
Next Year Payroll Process guide. You can click the step link to open additional information about the
step (as it is displayed in the complete guide).

The NYR Payroll Process Quick Checklist guides you through the necessary steps to create next
year's payroll. This process includes updating tables and employee information, calculating
salaries, performing edits, and interfacing payroll to Budget. This process occurs in the next year
and does not interfere with the current year processing.

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

Created: 02/01/2024
Reviewed: 03/19/2026
Revised: 03/31/2026

| Some of the images and/or examples provided in this document are for informational
£.% % purposes only and may not completely represent your LEA's process.

Prerequisites
Prerequisites:

Gather Beneficial Data:

@ This section is strictly for informational purposes.

Before performing the next year payroll process, review the following tables and gather the data that
will be beneficial while you are updating this information for the new school year.

Proposed/Approved Next Year Salary Schedule
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Personnel > Tables > Salaries

Once a salary table is assigned to an employee on the Payroll > Maintenance > Staff Job/Pay Data >
Job Info tab, the table can be updated and salary calculations can be run for all affected employees
eliminating the need to update the information for each individual employee.

Proposed/Approved Next Year Workday Calendars

Personnel > Tables > Workday Calendars > School Calendar

After receiving the upcoming approved school year calendars, you can create a calendar(s) to assist
with documenting employee workdays and holidays. It is helpful to plan future pay dates and payoff
dates for the next school year in advance.

Reference State Minimum Salary Schedule

Review the TEA Minimum Salary Schedules for changes effective with the new school year.

Accrual Calendar Information

Payroll > Tables > Accrual Calendars > Accrual Calendar

O Creating and assigning an accrual calendar to employees allows you to maintain the accrual
calculations throughout the school year. You can obtain workdays by month information from the
workday calendars.

[ Be sure to keep the same accrual codes for each accrual calendar. This method allows for
consistency and eliminates the need to update the information for each individual employee.

O Accounting for the August EQY accrued days in the accrual calendar and using the EQY Payroll
Accruals process assists in properly accounting for accruals across the fiscal years.

Update Next Year Staffing Changes

When payroll opens for the next year, be sure to keep up with the following staffing updates:
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* Resignations and new hires: Update the employee status as resignations and new hires are

approved to allow the appropriate budget amounts to be created and interfaced.
o Review TSDS Best Practices for New Employee Records.
o Review TSDS Best Practices for Terminated Employee Records.

e Campus level changes: Update the job table and employment information as jobs move from
one campus to another.

» Distribution changes: Update employee distributions based on budget changes.

* Update extra duty/stipend pay: Update the extra duty table to reflect changes and
payments. Also, update the balance on the Payroll > Maintenance > Staff Job/Pay Data > Pay
Info tab. The next year payroll budget calculations use the s-type extra duty remaining amount;
therefore, it is important to verify that these amounts have been updated.

¢ Update substitute pay: If substitute pay rates change, update the Personnel > Tables >
Salaries > Substitute tab, which is associated with entering employee substitute leave
transmittals.

Extract Third Party Administrator (benefits) Information

Payroll > Utilities > Employee Benefits Interface > Extract

Perform an extract to create the files containing deductions and demographic data to be sent to the
third-party vendor.

Only deduction codes that have an Extract Ded Cd (extract deduction code) on the Payroll > Tables
> Tax/Deduction > Deduction Code are extracted.

After the new premiums are updated by the third-party administrator and the file is returned, you can
import the updated file making the changes to the next year deductions in one step.

Payroll > Utilities > Employee Benefits Interface > Import Annual File

This utility imports the next year employee benefit choices via a file created by your third-party
vendor. Importing data decreases the amount of time it takes to enter individual employee data
changes.

Manage Employee Change Requests

O Create a form for next year employee change requests. This form assists with data entry and
provides documentation.

O Set a deadline for employee change requests prior to the end of the current school year to allow
time for clarification if needed.

O Update employee direct deposit information. Use caution when updating this information in the
next year frequency as the system will prompt you to update this information in the current year
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frequency.

O If your LEA has not already done so, set up the EmployeePortal application. EmployeePortal allows
employees to submit demographic changes and payroll (W-4 and direct deposit) changes. LEA-defined
options determine what changes can be made by the employee and the necessary approvals.

Before You Begin

Before you begin:
Things to Remember Prior to Beginning NYR Payroll

O Ensure open communication exists between the payroll office and business office.

e Verify that the Budget process is complete and the budget is open.
 Set potential deadlines for various presentations.

O Verify that you are logged on to the current pay frequency.

0 Remember: Next year calculations and distributions are validated to the new budget (N). Make
sure that the fiscal year on the distribution pages matches what is in the new budget (N). If it changes
during the process, perform a mass update.

Current and Next Year Shared Pages

The following pages are shared between the current year and next year. Use Caution
when updating these pages in the next year:

Personnel or Payroll > Tables > District HR Options
Personnel > Tables > Credential

Payroll > Tables > Tax/Deductions

Payroll > Tables > Bank Codes

Personnel > Maintenance > Staff Demo (all tabs)
Personnel > Maintenance > Employment Info

Reminders

* New employees must have a Unique ID. Create a Personnel record and copy it to NY Payroll to
ensure that they are included in the Unique ID Extract.
¢ Do not update years of service or leave until Service Records have been created. This usually
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occurs between the June and July payrolls and is covered in the Service Record guide.
e Medicare On-Behalf is usually posted to the TRS website in late summer. In most cases, a
reminder is sent by your ESC so you can book actuals to Finance for the year and create a

budget for next year.

e Remember to update NY Payroll in Budget periodically to ensure that changes are updated. This

allows Budget to remain as current as possible.

Extract IDs

Extract IDs can be used to group similar employees to allow for easier and more accurate mass
updates. For example, most 187-day teachers/aides have the same contract Begin and End Dates,
same Calendar Code, and the same Payoff Date, which may allow them to be grouped together by
extract ID making it easier to select that group of employees when performing Mass Updates.

To use extract IDs:

Personnel > Tables > Job/Contract > Extract ID

O Add or modify extract IDs.

JOB CODES CONTRACT CLASS

COMTRALCT TERM

CONTRALT YEAR

EXTRACT ID

Extract ld Description

—

— — — e ey

TERMIMNATIOM REASON

I l These extract IDs must meet your LEA's criteria so it is important for the Payroll and
&)  Personnel departments to communicate about the setup and use of extract IDs.
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Personnel > Maintenance > Employment Info

O After extract IDs are established, assign or modify the extract IDs for each individual employee
record.

v

Employes: [DW‘EE ] [ Retriewve ] l Directory _J

EMPLOYMENT INFO

Ervtome s Employed

Employment Dates Employment Types Rastires Infonmation

Oiginal Emp Date: Employment Type: [f [FT L rep—— ‘3 Retrement Date:

Latest Re-Employ Dite: Sub Type: [ wl Retiree Employment Type: [ =
Tarmination Diate: Highly Qualifiedt D Talow Retiree Surchargs: D

Extract for TSDS: D Year Round: D WY Taioe Retiree Surchange: D

Terminatsan Reason [:I Eatract 10 (02 TEACHERS 10 MONTH )

Eligible for Rg-hare O =3 2 Masters ~

Percent Day Emploved: Too% o

Pt Day Emloyed Effective Date: (5555555 |

Payroll > Utilities > Mass Update

O After extract IDs are assigned as needed, select the applicable Extract ID and run the necessary
mass update for a specified group of employees. Extract IDs can also assist in sorting and filtering
report data.

Farameiers
Py Szt Pt J
& actve (Clinsctiee (C) Both Primary Campmac ALl ] Payelt Dare |
Pay Campus: |J'-"—“L Fronqunicy. i:i Moty NYR U’j
P Tipe: [w %] ConwuaegieDu | ] Satary Concapt: [am v
Jolo Coce: AL %] Comeacetpme [ | [Emctio: 62 Teacrins wamonmn ] |
Acamtbede M | et || p——r— i
ST —
Pricar ¥ Ermgs Diatac
DEDUCTIONS LEAVE EMPLOYEE EXTRA DUTY 308 CODE SALARY CALOULATION
Fenet Increment [Hodity [ it
Dl i Qe — e N
Gl’lu:am-n [ Dc#m" b D"'"" I. ] "t o s "_—— E——_I
[ Dock Ao e o B et Dy [pe-03-202q) () stane snen CommnctEndDate: [ ] [ )
[0 wemerghenament Etig e [f) Contract End Dute @: [l uimat 20 Mtr Days Emplc :_ CHE |
O pro-ticte - ) tx O Bt g7 || () Tocullob Experence sermommmosmal_ ||
éf:j‘u:ril:g;mm 21 [ 9 of Menehy in Contracy i ] ¥ Employment Date ":.. b .I Casmract Duyic | B0t TRS v-l_r.\w TRS V_
[ #58 Seatt Cuata Code = | [ Comtract Oars o - it ol [ ]
[[] RS Member Pos "_JJD Lot Contrict Dy ]
T Drwet )
[Murmber of] D Py Grada ]

2] A oy L 1 [ wocat serwate
(i) Aemaining Payments | 12 [ ttan D
(] W Enoual Fayments [ sy
() WE Remainingg Puymests @ [0 wty virs St

ARNAAAE

Personnel > Reports > User Created Reports
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If your LEA uses extract IDs to group employees for mass updates, generate a user-created report to
verify that extract IDs are correctly assigned to employees.

If extract IDs are missing or need to be changed, you can manually update individual employee
records using the Personnel > Maintenance > Employment Info page.

NYR Payroll Process Quick Checklist

Task Reference
the Step in
NYR Payroll
Process
Guide

Update Payroll Current Pay Frequency

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry
U Step 1
Verify August EQY payroll accruals.

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables
u Step 2
Clear all next year (NYR) tables.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables
u Step 3
Copy all current year (CYR) tables to next year (NYR).

Payroll > Next Year > Copy CYR Staff to NYR

Copy the employees from the current year payroll to the next year payroll. If you
have multiple pay frequencies, complete this task in all pay frequencies.

* Under Pay Status, select Active to copy only active employees.

* In the Pay Type field, select E Exclude Substitute.

bl Under Options, it is recommended to select Include Employees with Step 4
Termination Date to copy active employees with a termination date on the
Personnel > Maintenance > Employment Info tab.
O Click Execute to begin the process of copying the employees.

O|Verify employee data using various reports. Step 5

Update Personnel

Personnel > Tables > Credential

Update Credential tabs as needed.
U Step 6
Note: The Teaching Specialization tab is used to report Pre-K teachers for Class
Roster so if there have been changes, you can make those updates now in
anticipation of the submission.
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Task Reference
the Step in
NYR Payroll
Process
Guide

Personnel > Tables > Salaries NYR

Update the next year salary tables to reflect any changes to the salary schedules
(anticipated or known).

* Local Annual - This tab is the most commonly used. You can make mass
updates by percent or dollar amount, or by employee. To see a change before
saving the record, enter the change and click Default. The original annual amount
Olis displayed in the Annual Amt column, the percent or dollar is increased, and the |Step 7
New Amount is displayed. Click Save. If decreasing a salary, enter a negative
percent or dollar amount.

* Hourly/Daily and Midpoint - These tabs can be updated in the same way if
used by your LEA.

* Substitute - This tab can be manually updated as needed.

» State Min - This tab is updated via a file upload when applicable. These
instructions are sent separately with the file as needed.

Personnel > Tables > Job/Contract > Job Codes NYR

Add or update job codes as needed.

ad Step 8
Note: You can assign accrual codes, Workers’ Comp codes, and FTE hours to
lessen the workload when completing tabs for new employees.
Personnel > Tables > Workday Calendars
Create calendars.
» Calendars tied to a numeric frequency (e.g., 6) are used for current year.
O° Calendars tied to an alpha frequency (e.g., F) are used for next year. Use the Step 9

spyglass to create or edit calendars as needed.

* You can copy calendars that begin in the same month. Example: If you create
the 10-month calendar beginning in August for teachers for 187 days, you can
copy the calendar to the Food Service and Bus Driving calendar codes, and then
edit them to reflect the differences such as begin dates and holidays.

Personnel > Maintenance > Staff Demo > Demographic
U Step 10
Update staff demographic data.

Personnel > Maintenance > Employment Info

Review retirees and verify that NY Take Retiree Surcharge is selected in order
to include the retiree surcharge when the Extract Payroll to Budget process is
performed. Step 11
Review and update terminated employees. It is best practice to not only update
the Termination Date and Reason but, if applicable, update the Auxiliary Role
ID and Paraprofessional Certification End Date. Also, update the End Date on
the employee's responsibility record.

Update Payroll Next Year Pay Frequency
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Task Reference
the Step in
NYR Payroll
Process
Guide

Payroll > Tables > Tax/Deductions

Update the following tabs as needed.

* FICA Tax - This tab is used to copy rates from the current calendar year to next
calendar year.

* Unemployment - This tab can be updated as applicable to your LEA. Some LEA's
budget by selecting Taxable while others may select Reimbursable and manually
add an amount in Budget. Verify how your LEA is handling unemployment in the
current year to determine if you want to continue. You can contact your regional
ESC consultant if you need additional assistance but set the next calendar year as
O|desired so calculations will be accurate for the entire year. DO NOT change the Step 12
current calendar year as that is being used in the current year payroll.

* TRS Rates - This tab should have been updated previously. Review for accuracy.
* Workers' Compensation - This tab can be updated as rates change. Be sure to
verify the accuracy of the rates as some carriers send the rates as decimals and
others send as a percentage; therefore, you will need to add the decimal.

* Deduction Codes - This tab can be updated as you receive updated information
from your TPA or make changes to deductions that are offered. The majority of
LEAs import deduction changes for each employee using a file from your TPA.
Reviews the table for any necessary changes.

Payroll > Tables > Accrual Calendars > Accrual Calendar

Create accrual calendars as needed. Review codes in the current pay frequency to
ensure you are duplicating dates and days to the correct group.

* Most districts only accrue 10-month employees. If that is true for you, each code
should begin with August 31 and show the number of days that group of

4 employees will work in August. Add 12 more lines and enter the true/regular Pay Step 13
Dates. Enter the days employees work in the month associated with each pay date.
* Typically, July and August (and sometimes June) will show the pay date and zero
days, but they still must be included.
* Dates used (with the exception of August 31) must match the Pay Dates that will
be built in the Pay Date Table.
Payroll > Utilities > Mass Update > Deductions
U If applicable, mass update the Employer Contribution and Remaining Step 14
Payments for all employees with health care and other employer paid deductions.
Payroll > Utilities > Mass Update > Employee
Mass update the Pay Step and State Step fields for all employees tied to a salary
table. This allows preliminary payroll data to be sent to Budget as a starting point.
Consider repeating this step as follows for each pay type to ensure that all
0 employees are incremented properly. Step 15

* For Pay Type 1 (Contracted Employees), increment once for both the Pay Step
and State Step.

* For Pay Type 2 (Non-contracted Employees), only increment the Pay Step for
these employees as they are not subject to Stat Min making the State Step
unnecessary.

* If needed, repeat for Pay Type 3 (Hourly Employees).
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Task Reference
the Step in
NYR Payroll
Process
Guide

Payroll > Utilities > Mass Update > Employee

Mass update data as needed. The following fields are commonly updated.

* Fiscal Year - If some employees should not be incremented to the next fiscal
year, repeat this step only selecting specific employees and mass update them
back to the correct fiscal year. An example of this may include those paid with
Elementary and Secondary School Emergency Relief (ESSER) Programs.

* Contract Begin Date

* Contract End Date

* Nbr Days Empld

* # of Months in Contract

* Payoff Date

* (Number of) Annual Payments

* (Number of) Remaining Payments

* (Number of) WC Annual Payments

* (Number of) WC Remaining Payments

Step 16

Payroll > Utilities > Mass Update > Extra Duty

O/Mass update the remaining payments on all extra duties for applicable employees. |Step 17
Complete the Remain Pymts field under Change Existing Extra Duty Code
Information.

Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code
Comparison

U Generate the report before calculating salaries. This report is used to verify the Step 18
distribution codes from the master distribution page against the account codes in
Budget.

Payroll > Utilities > Mass Update > Salary Calculations

O|Perform salary calculations for employees. An error report will provide a list of Step 19
employees not tied to a salary table. Use this list as a reminder of which
employees need to be manually updated.

Payroll > Maintenance > Staff Job/Pay Data > Job Info and Distributions
Manually add or update salary information for those employees not tied to salary
tables. For example, most often, administrators such as the Superintendent or
O|Principal. Step 20
* Manually enter an estimated annual salary amount for pay type 3 (Hourly)
employees in order to budget for these employees.

* Add new employees as information becomes available.

Verify Accuracy of Data

O|Verify TRS fields. Step 21

O|Verify salary calculations. Step 22
Payroll > Utilities > Payroll Simulation > Addendum

U Step 23

Verify data using addendum sheets.

Payroll > Utilities > Pre-Edit Payroll Data
U Step 24
Perform “test payroll”.
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Task Reference
the Step in
NYR Payroll
Process
Guide

Payroll > Utilities > Employee Benefits Interface > Import Annual File
| Step 25
Perform staff benefits updates.

Interface NY Payroll to Budget - These steps can be repeated as often as
necessary to update budget data.

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Payroll Account
Codes

| Step 26
Work across the tabs to extract next year payroll data. Review the reports and
interface to Budget to provide preliminary budget amounts if needed.

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Reports

| Step 27
Verify the Extract Reports tab.

O|(If necessary) Perform another extract and interface to Budget. Step 28
Payroll > Next Year > Interface NY Payroll to NY Budget > Interface to Budget

| Step 29

Interface to Budget.
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https://help.ascendertx.com/test/business/doku.php/general/quickview/nextyearpayroll/step15
https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractpayrollaccountcodes
https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractpayrollaccountcodes
https://help.ascendertx.com/test/business/doku.php/general/quickview/nextyearpayroll/step21
https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractreports
https://help.ascendertx.com/test/business/doku.php/general/quickview/nextyearpayroll/step22
https://help.ascendertx.com/test/business/doku.php/general/quickview/nextyearpayroll/step23
https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/interfacetobudget
https://help.ascendertx.com/test/business/doku.php/general/quickview/nextyearpayroll/step24
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